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1. INSTRUCTIONS 
 
This template is meant to be a “COBie Cookbook.”    The steps required to streamline existing paper 
processes and redundant data entry and file processing are outlined in this template.   
 
The most efficient way for a Contractor to use this document is: 
 

1) The person preparing the COBie Implementation Plan shall review this template Plan to 
understand how COBie data can be used to simplify current contract deliverables. 
 

2) The preparer shall make a copy of this template and renaming it to reflect the various versions of 
the document.  
 

3) If this is a design-build project, the preparer shall facilitate a conversation with the lead Architect 
and consulting engineers about the creation of COBie design deliverables. 
 

4) If this is construct contract, or design-build project, the preparer shall facilitate a conversation 
with the construction contractor and subcontractors about the creation of COBie design 
deliverables. 
 

5) The preparer shall capture the information needed to apply this generic Plan to a specific project. 
 

6) To complete the Plan the preparer shall fill in the required content, make edits, and update each 
Plan section as instructed.  
 

7) The prime Contractor shall submit any Requests for Information on the scope of this Plan to the 
Government for response.  
 

8) Contractors with their own, equivalent, processes may substitute their processes as appropriate to 
meet the requirements of the COBie Specification.   
 

9) The preparer shall clearly document all Contractor substitutions. 
 

10) The preparer shall update all page footers and tables of contents.   The “DRAFT” watermark shall 
be removed.  Preparer instructions shall be removed from the final Plan document.  
 

11) The prime contractor shall submit the project-specific Plan to the Government for Approval. 
 

12) Government Approval is contingent upon (1) the completeness of the plan and (2) execution of 
the approved plan through the life of the project.  
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2. VERSION CONTROL 
 

This version of the COBie Information Delivery Plan is the most recent Plan submission.   Previous 
COBie Information Delivery Plan versions are noted in the table below. 

Preparer Instructions:  Add/Remove rows as needed to document required information. 
 

Date 
Submitted 

Date 
Approved 

Version 
Number Reason for Submission of New Version 

  1.0 initial submission 
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3. SUBSTITUTIONS 
The following substitutions or changes from the draft COBie Information Delivery Plan Template are 
documented in this plan:  

Preparer Instructions:  Add/Remove rows as needed to document required information. 
If no substitutions, so state in first row of form.  

 

Date Description of Substitution  Current Page 
Reference 
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4. REQUESTS FOR INFORMATION 
The following requests for information related to the topics covered in this Plan, and their resolution, are 
noted as shown in the table below.  

Preparer Instructions:  Add/Remove rows as needed to document required information. 
If no substitutions, so state in first row of form.  

 

Date 
Submitted 

Date 
Resolved Description of Request for Information 

 Current Page 
Reference 
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5. BASIC REQUIREMENTS 
Preparer Instructions:  Identify any requirements not met under this Information 
Delivery Plan with the “strikeout” text style. This is an example of strikeout text. 

 

5.1 COBie QC Manager 
The COBie QC Manager identified in this project has the following proficiencies: 

• Use of Microsoft Excel 
o Use of multi-sheet Excel Workbooks 
o Use of Excel Filtering/Sorting Capabilities 

 
• Use of Adobe Acrobat Reader 

o Use of Adobe Acrobat Reader Comment Tools 
o Use of Adobe Acrobat Reader Printing Tools 

 
• Computer Administrative support 

o Ability to update and install PC software 
o Ability to install and update Java  

 
• Use of Adobe Acrobat Pro (optional) 

o Bookmarking Tool 
o Optical Character Recognition Tool 

5.2 COBie Subcontractor POC’s 
Subcontractor POC’s will be required to provide information on their contracted parts of the construction.  
For example, subcontractor personnel are required to document nameplate information when equipment is 
installed.  The COBie Subcontractor POC’s will have the same skills as the COBie QC Manager except 
as follows: 

Preparer Instructions:  Identify limitations on subcontractor POC qualifications 
 

5.3 Computer Hardware 
• PC, running Microsoft Windows 7 (or later) 
• 64-bit Operating System (click on Start > Control Panel > System to check) 
• Installed memory (RAM) 4.00 GB (8.00 GB recommended for IFC-based models) 
• Latest Java version installed (https://www.java.com/en/download/installed.jsp)  

5.4 Computer Software 
• Microsoft Excel 2007 (or later/equivalent) 
• Adobe Acrobat Reader (http://get.adobe.com/reader/) 
• Oracle JAVA (https://java.com/en/download/index.jsp) 
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• ERDC COBie Tool Kit (http://projects.buildingsmartalliance.org/files/?artifact_id=5466) 
• (optional) Adobe Acrobat Pro 
• (optional) ProjNet-eSubmittal (https://www.projnet.org/)  
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6. COBie QC MANAGER DESIGNATION 
 
The following personnel are designated as the Primary and Alternate COBie QC Managers for this 
project: 
 

Preparer Instructions:  Add rows as needed to the table below.   
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

COBie QC 
Manager 
(Primary) 

     

COBie QC 
Manager 

(Alternate) 
     

 
The COBie Quality Control (QC) Manager shall be responsible for overseeing overall implementation of 
the COBie Implementation Plan and will coordinate the extraction, collection, collating, testing, and 
delivery of all COBie-specified deliverables.  

Duties 

• Preparation, approval and implementation of COBie Information Delivery Plan 
• Preparation, review, and approval of all COBie-specific submittals 
• Preparation, review, and approval of all COBie-formatted submittals 

 
• Documentation and submission  of current COBie collection processes 
• Documentation, execution, and submission  of streamlined COBie collection processes 
• Identification, designation, and documentation of  all COBie data collection personnel 
• Coordination of all COBie data collection personnel to ensure accurate data merging 
• Provision of COBie technical expertise to all COBie data collection personnel 
• Carry out and lead monthly COBie progress meetings 

 
• Identification, selection, and operation of all applicable COBie-supporting software 
• Provision of computer hardware necessary to operate the COBie Tool Kit, or alternate 

 
• Submission of request for equipment photographs, Documentation of Response 
• If approved, preparation, review, and approval of equipment photographs 
• Submission of request for electronic O&M manuals, Documentation of Response  
• If approved, preparation, review, and approval of electronic O&M manuals 
• Submission of request for electronic information delivery media and encryption specification 
• Preparation, review, and approval of all electronic media, as specified 
• Encryption of all electronic media, as specified 
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7. MAJOR COBie WORK ACTIVITIES  
Preparer Instructions:  (a) Identify any requirements not met under this Information 
Delivery Plan with the “strikeout” text style.    This is an example of strikeout text. (b) 
Document specific activities in the later sections of this Plan.  

 
1. Mobilization 

Develop and Implement COBie Information Delivery Plan 
Document requirements for electronic vs. paper O&M manuals 
Document requirements for physical media and, if needed, encryption 
Coordinate with subcontractors to provide COBie-based submittals and as-built equipment data 
Document requirements for as-installed equipment photography 
 

2.Produce COBie-specific Design Deliverables 
 (design-build projects only)  
30% Architectural Design 
60% Architectural Design 
100% Construction Drawings 

3. Produce COBie-specific Construction Deliverables 
Construction Mobilization 
60% Completion 
Beneficial Occupancy 
Fiscal Completion 

 
 
4. Produce COBie Project Submittals 

Door Schedule 
Room Finish Schedule 
Hardware Schedule 
Signage Schedule 
As-Installed Equipment Schedule 
As-Installed Warranty Tags 

 
5. Produce COBie O&M Submittals 

Approved Submittals 
Spare Parts Schedule  
Warranty Certificates and Data 
Preventative Maintenance Plans  
Diagnostic Testing Plans  
Repair and Replacement Plans 
Real Property Equipment Transfer Report 
Operations and Maintenance Manuals 

 
 
6. COBie Software Selection 

ERDC COBie Tool Kit 
Selection of alternative COTS product (optional) 
Process of exporting current templates 

 
7. COBie Submittal Templates 

Exporting Submittal Templates 
Capturing Submittals/Updates As-required 
Importing and Merging Submittal Data 

 
 
8. As-Installed Equipment Capture 

Coordination with subcontractors 
Distribution of templates to subcontractors 
Monthly submission of templates 
Roll-up of subcontractor data 

 

 
9. Electronic Submittal Processing 

Process for marking and submitting mfg. PDF’s  
Process for naming/archiving approved PDF’s 
Bookmarking or separating individual types 
Use of ProjNet-eSubmittal (optional) 

 
 
10. Feeding COBie data to Corps’ RMS 

Identification of Specific RMS data feed by COBie 
ERDC COBie Tool Kit automates RMS data entry 

 

 
11. Production of Electronic O&M Manuals  

Manual production of electronic O&M manuals 
ERDC COBie Tool Kit automates O&M manuals 
ERDC COBie Tool Kit production of eBook 
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7.2. COBie Software Selection 
 
The following software will be used to test the quality of COBie-specific submittals:  
 

Product Name Used For 
ERDC COBie Tool Kit   
Substituted Product  

 
The following software will be used to export templates and import updates to the COBie data set during 
the course of a project:  
 

Product Name Used For 
ERDC COBie Tool Kit   
Substituted Product  

 

7.3. Produce COBie-specific Design Deliverables 

 
Preparer Instructions: (a) This section is applicable to the design phase of design-build 
contracts only.  Remove the content of this section and enter “n/a” for construction only-
contracts. (b) Make the selection required. 

 
Architectural discipline design deliverables shall be produced directly from native Building Information 
Modeling (or other) Design Software tool that has participated in a COBie Challenge.    Architectural and 
other design documents produced by engineering and other disciplines included in this project shall be 
produced from the following software. 
 

Design Discipline Software Used 
Architectural  

Mechanical  
Plumbing   
Electrical   

Control System  
Fire Suppression System   

Other  
 
For COBie-specific design deliverables, the following product shall be used to merge information from 
engineering disciplines with the information from the architectural model to produce a single, unified 
COBie data set. 
 

Model Merging Software   
 
The format of each COBie-specific deliverable shall be tested using [ERDC COBie Tool Kit, or 
approved substitute] prior to submitting that deliverable to the Government.    
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The content of each COBie-specific file shall be evaluated based on the requirement that “the data on 
drawing schedules match the data in the COBie file.”  The following workflow shall be used within each 
design discipline, and associated software, to ensure that design schedule information may be exported 
directly into a COBie file. 
 
Each COBie-specific file will include the complete set of design documents in PDF format. One PDF file 
shall be provided for each drawing sheet.   
 

7.2. Produce COBie-specific Construction Deliverables 

 
Preparer Instructions: Make the selection required. 

 
A Construction Mobilization model will be prepared to provide the outline of facility assets needed to 
support the capture of COBie data through the construction phase.  The software used may be any 
software that supports COBie for design or construction that has participated in a COBie Challenge.   
 
Unless an approved substitution has been submitted and approved, COBie construction deliverables shall 
be created using [ERDC COBie Tool Kit, or approved substitute].  The output of each deliverable shall 
reflect the current state of each of the COBie-formatted submittals that have been imported into [ERDC 
COBie Tool Kit, or approved substitute] 
 

COBie-Specific Deliverable Software Used 
Construction Mobilization  [to be defined by Contractor] 

60% Completion ERDC COBie Tool Kit 
Beneficial Occupancy ERDC COBie Tool Kit 

Fiscal Completion ERDC COBie Tool Kit 
 
The format of each COBie-specific deliverable shall be tested using [ERDC COBie Tool Kit, or 
approved substitute] Construction Quality Control Report prior to submitting that deliverable to the 
Government. 
 
The content of each COBie-specific file shall be evaluated based on the requirement that “the data on 
drawing schedules match the data in the COBie file.”  The following workflow shall be used within each 
design discipline, and associated software, to ensure that design schedule information may be exported 
directly into a COBie file. 
 
Each COBie-specific file will include the complete set of design documents, amendments and contract 
modifications, in PDF format.  One PDF file shall be provided for each drawing sheet.  One PDF file 
shall be provided for each amendment and each modification.  
 
Each COBie-specific file will include PDF files for each approved or acknowledged submittal received.   
Submittals that have not been approved or acknowledged shall not be included in any COBie 
submissions. 
 
If allowed by the Government, each COBie-specific file will include JPEG files for each piece of installed 
equipment. 
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7.3. Produce COBie Project Submittals 
 

Preparer Instructions: Make the selection based on current project plans.  
 
After importing the Construction Mobilization model, which forms the outline of requirements for the 
entire project, into [ERDC COBie Tool Kit, or approved substitute], the following procedure shall be 
used by the COBie QC Manager to prepare and create COBie-formatted Submittals 
 

Step Description Responsibility 
a Select and export the needed ERDC COBie Tool Kit template COBie QC Manager 
b Deliver the template to personnel developing the submittal COBie QC Manager 
c Those personnel enter their submittal data into the template Submittal Creator 
d Those personnel provide the updated template back to the  Submittal Creator 
e Check the submittal for content accuracy, updated as required COBie QC Manager 
f Import the submittal into the ERDC COBie Tool Kit COBie QC Manager 
g Export the submittal (as data, document or RMS QCS format) COBie QC Manager 
h Deliver the submittal to the Government for appropriate action COBie QC Manager 

 
The following submittals are typically provided once, near the start of the project, and do not need to be 
updated unless there is a change to the project.   Unless a submittal is rejected for some reason, the 
process above is expected to be needed only once for each of these submittals: 
 

• Door Schedule 
• Room Finish Schedule 
• Hardware Schedule 
• Signage Schedule 

 
The following submittals are updated during the project to eliminate the requirement to conduct post-
installation job site surveys.  Each of these submittals will follow the process noted in the table above on 
a monthly basis.  The exported template will contain information previously entered information, as well 
as, blanks for information yet to be captured. 
 

• As-Installed Equipment Schedule 
• As-Installed Warranty Tags (if specified)  

 
As-Installed Equipment Schedules and Warranty Tags information will be completed by the subcontractor 
responsible for the installation and/or testing of that type of equipment.  Reliance on the installer to 
capture as-installed product data will ensure that post-installation job surveys will not need to be 
conducted.   The following subcontractors will be required to complete these templates.  
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Discipline Responsible Contractor/Subcontractor /Installer 
Architectural Components  

Mechanical Equipment   
Plumbing Fixtures/Equipment   

Electrical Products   
Control System Products  

Fire Suppression System Products   
Other Products  

 

7.4. Produce COBie O&M Submittals 
 

Preparer Instructions: Make the selection based on current project plans.  
 
The majority of the information contained in O&M manuals is required to be provided, prior to the end of 
the project as standard submittals.  The objective of creating COBie O&M submittals is to capture these 
standard submittal documents electronically to allow the information to be re-used in whatever format 
that is required on this project.    
 
The following procedure will be used to create the RMS QCS submittal register. Essential in this process 
is the identification of each submittal with a specific product type or system that is already in the COBie 
data file. 
 

Step Description Responsibility 
a Select and export the ERDC COBie Tool Kit Submittal template COBie QC Manager 
b Update the submittal register to reflect all expected submittals COBie QC Manager 
c Import the submittal register into the ERDC COBie Tool Kit COBie QC Manager 
d Export the submittal register (as data, document or RMS QCS) COBie QC Manager 

 
Submittal files are to be provided electronically, in PDF format, by individual manufacture product 
family.  The location of these files is to be provided in the COBie Submittal template.  Submittals that 
cross manufacturer families shall not be submitted.  Specific submittal documents within these documents 
are either to be identified by links found in the PDF document, or broken out into individual PDF files for 
each submittal type in the document.  In either case, these documents are to be linked directly to the 
COBie Submittal Register template. 
 
The following O&M submittals may be exported from [ERDC COBie Tool Kit, or approved 
substitute] and updated over time: 

 
• Warranty Data 
• Preventative Maintenance Plans 
• Diagnostic Testing Plans  
• Repair and Replacement Plans 
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Depending on the specifics of a given contract two templates are provided to delivery consumable, 
replacement, or on site parts 
 

• Product-Specific Parts and Consumables 
• General Building Parts and Consumables  

 
Given the collection of COBie data during the course of a project, the following O&M submittals may be 
exported from [ERDC COBie Tool Kit, or approved substitute] at any time, based upon the 
information currently found in the COBie data set.  
 

• Operations and Maintenance Manuals 
• Real Property Equipment Transfer Report 

 

7.6. COBie Submittal Templates 
 

Preparer Instructions: Make the selection based on current project plans.  
 
During the use of the [ERDC COBie Tool Kit, or approved substitute], the COBie QC Manager will 
process the export of the current template data and the import of updated/as-built COBie data.  There are 
two templates provided to capture electronic submittal files: 
 

• Product Type Submittals 
• Product-Specific Submittals 

 
The COBie QC Manager may provide subsets of these templates, as needed, to specific contractor and 
subcontractor personnel based on the scope of their specific work.  
 
The COBie QC Manager will ensure that regular updates are provided to as-built equipment information 
from specific contractor and subcontractor personnel to eliminate the requirement for jobsite equipment 
surveys.  
 

7.7. As-Installed Equipment Capture 
 
The production and updating of installed equipment lists will be coordinated with the designated 
subcontractors.  To produce a monthly roll-up of all equipment that appears on drawings schedules. 

  

7.8. Electronic Submittal Processing 
 

Preparer Instructions: Customize this section to identify the way in which product data 
and other electronic documentation are to be captured for submission concurrent with 
relevant COBie-based information.  
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The COBie QC Manager will ensure that original manufacturer PDF’s are used as the basis for all 
submittals.  All PDF’s will be down-sized to “Standard” quality to ensure minimum file size.   
 
To ensure the correct processing of automated O&M Manuals, the COBie QC Manager will ensure that 
each PDF provided is limited to a single manufacturer’s product type.   Individual submittals within those 
PDF files will be identified either by PDF book mark or by exporting each individual submittal type file 
within the manufacturer’s original PDF. 
 
The eSubmittal program is the only electronic submittal system authorized by Corps of Engineers’ 
regulation and integrated with the Corps’ Resident Management System. The contractor [IS/IS NOT] 
planning to use the ProjNet-eSubmittal register to submit, review, and archive PDF documents for all 
approved submittals. 
 
The COBie QC Manager will use the following naming convention for all COBie submittal files when 
documenting the location in the COBie Submittal Template: 
 
COBie.TypeName + Submittal Type + version  
 
In the following example, separate files are provided for each submittal type: 
 

• Pump-Type1-ProductData-v01 
• Pump-Type1-InstallationInstructions-v01 
• Pump-Type1-ReplacementParts-v01 
• Pump-Type1-WarrantyCertificate-v01 
 

7.9. Importing COBie data into the Resident Management System 
 

Preparer Instructions: (a) Make the selection based on current project plans.  (b) 
Training on the use of the Resident Management System QCS Module will be provided 
by the RMS Center of Expertise.  

 
 
The ERDC COBie Tool Kit allows information to be captured through the [ERDC COBie Tool Kit, or 
approved substitute] and then be fed to Corps of Engineers’ Resident Management System, Contractor 
Quality Control module (RMS QCS). This transfer eliminates the need to simplify the collection of 
information required by RMS QCS. 

  

7.10. Production of Electronic O&M Manuals  
 

Preparer Instructions: Make the selection based on current project plans.  
 
The COBie QC Manager will produce electronic O&M Manuals through the [ERDC COBie Tool Kit, or 
approved substitute] software.  The resulting set of files will be created in an eBook format suitable for 
printing or electronic transmission to the Government.  
  

5-Mar-14 DRAFT - COBie Information Delivery Plan Template 19 



 

8. COBie-FORMATTED TEMPLATES 
 

Preparer Instructions: (a) Identify the responsible parties in the tables below. Remove any 
unused. (b) If a specific template is not required remove the table and add “n/a” under the 
heading. 
 
The following COBie Templates capture the party responsible to provide each template based on the plan 
for this specific project shall be identified in each sub section. 

8.1. Schedule - Doors 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.2. Schedule – Room Finish 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.3. Schedule - Signage 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.4. Submittals - Hardware 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 
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8.5. Submittals - Product 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.6. Submittals – Product Type 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.7. Submittals - System 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.8. Installed Products 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.9. Warranties – Product Tags 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 
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8.10. Warranties – Product Types 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.11. Files - Drawings 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.12. Files - Photos 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.13. Consumables - General 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.14. Consumables – Product Types 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 
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8.15. Plan – Product Types - Maintenance 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.16. Plan – Product Types – Diagnostic and Repair 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 

8.17. Plan – System - Operations 
 

ROLE ORGANIZATION NAME EMAIL LOCATION PHONE 

      

      

 
  

5-Mar-14 DRAFT - COBie Information Delivery Plan Template 23 



 

9. USEFUL SPREADSHEET FUNCTIONS 
 
While COBie data is provided in the very easy to use MS-Excel spreadsheet format, many COBie QC 
Managers may not be familiar with some functions support the creation of COBie Template sub-sets that 
maybe given to individual contractor or subcontractor personnel responsible for the deliverables identified 
in this plan.  While this document is not intended to be a tutorial on MS-Excel, the following specific 
questions are answered to support the COBie QC Manager.  

9.1. NO Changes to Template Sheets and Columns 
Since MS-Excel is a very easy to use tool, some will think that changing the Template files is useful and 
permissible.  This is NOT the case.  Template worksheet names and column headings may not, 
under any circumstances be changed.  Users may enter data, sort, filter, and hide data, however, other 
changes keep the ERDC COBie Tool Kit from properly importing any information in that changed file.  

9.2. Sorting Template Data  
In MS-Excel 2007 begin by highlighting the first row of the needed COBie template.  That first row will 
be the row containing the headings for data found in that template.   Now click the menu options Data > 
Filter.  Notice now that there is an arrow in the bottom right corner of each heading cell.   

Left-clicking on that arrow will show the filter and sorting window.   The options “Sort A to Z” and “Sort 
Z to A” will sort that column of data in the order identified.  Notice that when the sort option is selected 
all other rows in the worksheet are sorted at the same time.  

You may also find that sorting the rows in one or another order allows you to see information sorted in 
consistent ways within a given category.  

9.3. Filtering Template Data  
In MS-Excel 2007 begin by highlighting the first row of the needed COBie template.  That first row will 
be the row containing the headings for data found in that template.   Now click the menu options Data > 
Filter.  Notice now that there is an arrow in the bottom right corner of each heading cell.   

Left-clicking on that arrow will show the filter and sorting window.   At the bottom of this window is a 
list of check boxes called “Text Filters”.  Selecting and unselecting these options, combined with sorting, 
will allow you to get directly to the information of interest. Notice that the row numbers to the left of the 
Template will no longer be contagious.  Filtering does not remove these other rows, just hides them.  

The reader is strongly cautioned about making changes in filtered spreadsheets as information in both 
filtered and hidden rows will be made on bulk changes.   

9.4. Creating and Using Sub-Templates  
If a given COBie template is to be distributed to multiple contractor and subcontractor personnel to allow 
each to update only their information, this can be accomplished by created multiple sub-templates.  Each 
sub-template will be created by copying the initial, full, template to a new file whose name should reflect 
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both the base template and the individual or company receiving the file.  Once the new file is created, 
open that new file and delete all rows that are not of interest to that specific individual or company.  

An alternative to this process is to use the ERDC COBie Tool Kit to produce each sub-template needed. 

Once the sub-template has been updated by the responsible party, that sub-template may be directly 
imported back into the ERDC COBie Tool Kit.  To see the result from the importation of multiple sub-
templates, re-export the whole template again.  

9.5. How to keep people from changing the Excel data?  
In MS-Excel 2007 worksheets, rows, columns, and cells may be locked from changes by using the 
“Protect” function.  See Excel > Review > Protect.   The COBie QC Manager should note that the use of a 
password will be required to un-protect the worksheet.   

9.6. Putting COBie data back into BIM Software?  
While it is not recommended to do so unless there is a specification requiring this, some will need to put 
the COBie data back into a BIM model once the information has been collected.    Provided that the 
COBie Construction Mobilization Model was created with the same software into which the COBie data 
is to be imported it may be possible to backfill COBie data into the BIM software.   The first thing that 
will need to be checked is if the data in the COBie fields “ExtSystem”, “ExtObject”, and “ExtIdentifier” 
match the object identifiers for the related objects in the BIM model receiving the COBie data.  

If the identifiers match, then either native or third-part software is typically available to merge the COBie 
as-built project information with that of a BIM software product.  
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10. ELECTRONIC SUBMITTALS GUIDE 
Contractors are required to use original PDF files that are text searchable for COBie submittal documents.  
Scanned copies of faxed documents of manufacturer’s files or fabricator’s drawings are not permitted.   

COBie submittal documents may be electronically marked to indicate the selections or options chosen for 
a given product.  Annotations of deviations or optional selections appearing outside the submittal 
documents, shall be included in the body of the PDF file (possibly by the inclusion of an associated 
report). 

If the Contractor decides to produce COBie submittal documents by recreating standard paper submittals 
from original manufacture PDF documents, or to submit such documents via the optional ProjNet-
eSubmittal electronic submittal register.  For information about subscription to ProjNet-eSubmittal, 
contact dfernandez@nibs.org. 

10.1. Reduce PDF Size in Acrobat Reader 

Product manufacturer PDF Files are often produced by the marketing departments of their respective 
companies.  As a result the resolution of these files is often suitable for full-color, high-quality printing.  
When creating PDF’s of construction submittals only grayscale (black and white) and standard quality is 
required.  

To use Acrobat Reader to reduce the file size of color product catalog use the File > Print option.  Under 
“Adobe PDF Settings” tab, the “Default Setting” should be set to the “Standard” option.  Under the 
“Paper Quality” tab, the option “Black & White” should be selected. 

10.2. Annotate the PDF in Acrobat Reader 

Acrobat Reader may also be used to select products and/or options within a PDF file. To do this select 
View > Comment > Annotation.  The arrow and text box options may now be used, in the same way a 
maker or stamp would be used on a paper submittal.   To save these changes and use this file as an 
electronic submittal or COBie file attachment use the File > Save As option.  

10.3. PDF File Naming Convention 

When creating COBie submittal documents it will be important for both the person creating the files and 
those receiving the files to have an easy to use standard for naming each file.   The file naming 
convention to be used when creating COBie submittal documents is as follows:  “Object-SubmittalType-
VersionXX”. “Object” is the name of the content of the information, e.g. “Window-Type1” where the 
type number matches the drawing schedule (and COBie.Type.Name).  The list of “SubmittalType” (s) are 
provided in the next section.  The designation of Submittal Type is critical, since it is that information 
(and its designation within the COBie.Document.Category) that allows the file to be used both for the 
submittal, commissioning, and handover processes.  The version number of the file allows all parties to 
maintain version control of these documents.  The text “XX” is replaced by the number of the file, 
starting with “01”.  
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10.4. Allowed PDF File Contents 
PDF files shall not have internal letters of transmittal from suppliers and subcontractors.  Only 
the original electronic information and the Contractor’s Quality Control Representatives 
notations and identification of deviations (if any) shall be identified.  CQC Reps’ comments must 
either be marked on top of the manufacturer’s original file or added as one consolidated set of 
notes at the beginning of the PDF file.  Again, multiple letters documenting the transmission of 
submittal data through the Contractors’ supply chain are not to be included in COBie submittal 
documents.  

Most manufacturer product catalog files have multiple types of submittals.  In order to use 
submittal files to automatically create O&M manuals each of the types of individual submittals 
within those documents must be identified.    COBie submittal documents of the following types 
must each be explicitly identified.   The contractor is only responsible to produce those files that 
fall within the scope of their specific design-build or construction contract.   

• Design Reports 
• Design Review Comments 
• Contract Drawings 
• Contract Specifications 
• Contract Amendments 
• Contract Modifications 
• Manufacturer’s Product Data 
• Manufacturer Certifications 
• Manufacturer Instructions 
• Manufacturer PM Schedules 
• Manufacturer Warranty Certificates 
• Fabrication Drawings 
• Sample Image 
• Installed Equipment Photo 
• Test Reports 
• Consumables - Equipment 
• Consumables – Facility 
• Start-Up Procedures 
• Shut-Down Procedures 
• Normal Operating Instructions 
• Emergency Operating Instructions 
• System Flow Diagrams 
• Draft Property Transfer Report DD 1354 

There are two options to support the automated generation of O&M manuals using COBie 
submittal documents. 
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Option 1. Split Manufacturer’s files 

In this option, the COBie QC Manager is responsible to split files containing multiple types of 
COBie submittal documents into individual files corresponding to each different type of 
submittal.  This option may be accomplished using Adobe Acrobat Reader. 

Option 2. Bookmark Manufacturer’s files 

In this option, the COBie QC Manager is responsible to create internal bookmarks within a 
single COBie submittal document file using Adobe Acrobat Pro.  Using Adobe Acrobat Pro, the 
Tools > Content Editing > More Content > Add Bookmark allows the inclusion of 
bookmarks. To ensure that these bookmarks maybe used by applications consuming this 
information it is recommended that the bookmark be one single concatenated word without any 
punctuation or spaces.   

The Adobe document “Parameters for Opening PDF Files” dated April 2007 indicates that the way that 
these book marks can be identified is using the full name of the file, followed by a hashtag, followed by 
the name of the bookmark. The example, as it applies to our COBie files is:  “Object-SubmittalType-
VersionXX #WarrantyCertificate” 

10.5. Move PDF to a Project-Specific COBie Directory 

Once the COBie Submittal document has been created, it should be moved to a specific subdirectory to 
keep such files.  Ultimately, this subdirectory will be called “docs”.  The subdirectory will be placed 
within the directory that holds the main COBie index file.   If using the ERDC COBie Tool Kit, the 
creation of this directory structure will be completed automatically. 

10.6. Link PDF to COBie Submittal Document List 
 

To ensure that the COBie submittal document files are correctly linked into the overall COBie data set, 
and to ensure the proper automated creation of the electronic O&M manual, each COBie submittal 
document must appear as once as a single record in the COBie Submittal Documents Template.    

When using this template with files that contain embedded bookmarks note that both the file name, the 
hashtag, and the book mark must also appear COBie submittal documents template.  
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11. COBie-RMS QCS INTEGRATION 
 
This section identifies the specific places where RMS QCS data may be imported from the ERDC COBie 
Tool Kit.  Information regarding the specific capability to update RMS QCS data from ERDC COBie 
Tool Kit can be provided by the RMS Center, Los Angeles District, Corps of Engineers. 
 
The following procedure will be used to create the RMS QCS data identified in this section.  
 
Step Description Responsibility 
a Select and export the ERDC COBie Tool Kit export routine COBie QC Manager 
b Note the name/location of the export file COBie QC Manager 
c Login to RMS QCS COBie QC Manager 
d Import the export file into RMS QCS COBie QC Manager 
e Spot check the imported row-count and first and last records COBie QC Manager 

 
NOTE: To ensure that RMS data remains synced, the COBie QC Manager will exclusively capture use 
the ERDC COBie Tool Kit to capture and import the data necessary for the associated RMS QCS module. 
 

11.1. RMS QCS Requirements > Installed Property 
The COBie Installed Equipment Template provides the information needed to deliver data to this RMS 
QCS module.  
 

11.2. RMS QCS > QC Requirements > QC Tests 
The COBie Component-Specific Submittals provides the information needed to deliver information into 
this RMS QCS module.  
 

11.3. RMS QCS > QC Requirements > User Schools 
The COBie Preventative Maintenance and Diagnostic and Report Templates provide the information 
needed to deliver information into this RMS QCS module.  
 

11.4. RMS QCS > QC Requirements > Warranty Items 
The top, fixed-part, of this RMS QCS program form will contain information provided by the COBie 
Installed Equipment Template.  No specific import of this RMS QCS module is required.  
 

11.5. RMS QCS > QC Requirements > Transfer Property 
The COBie DD 1354 export form provides a significant portion of the information needed to complete the 
RMS QCS Transfer Property Form.   Following the import of COBie DD 1354 export data, the 
Contractors’ RMS POC will be require to complete the remaining transfer property data fields.  
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11.6. RMS QCS > Closeout > Real Property 
The COBie Parts and Consumables Templates provide the information needed to deliver data to this RMS 
QCS module. 
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12. ELECTRONIC O&M MANUAL & eBOOK 
The ERDC COBie Tool Kit will export all information collected during the course of the project and 
export that information one of several formats.  The Selection of the specific export format will depend 
upon the specific requirements identified by the Government. 

12.1. O&M Manual 
If the option for an electronic O&M manual is selected for use on this project, the ERDC COBie 
Tool Kit will produce one consolidated set of files for that purpose.   

12.2. O&M Quality Control Report 
The quality of the information exported the ERDC COBie Tool Kit is directly proportional to the 
quality of the information that was captured in the COBie Construction Mobilization Model as 
updated through the use of the COBie-formatted submittals.  The O&M Quality Control Report 
may be run at any time to identify potential gaps in the information in the database of the ERDC 
COBie Tool Kit. That set of gaps can form a helpful to-do list of tasks necessary to deliver 
electronic O&M Manuals. 

The O&M Quality Control Report cannot definitively determine if a specific data set meets, or 
does not meet, the requirements of UFGS 01 78 00, “Closeout Submittals.”   

This report works by comparing the basic asset information about rooms, zones, systems, 
equipment types, and specific equipment with a list of potentially required information and the 
information entered through the COBie templates.  An example of information that cannot be 
identified by the O&M Quality Control Report is that if system or equipment that were not 
identified in the COBie Construction Mobilization Model cannot be checked.   

12.3. O&M Manual Production 
The ERDC COBie Tool Kit will create the electronic O&M Manual by creating a website that 
can be provided, via approved media, to the Government.  This Manual will be comprised of 
files that contain reports from the ERDC COBie Tool Kit and linked files.  

When creating the electronic O&M Manual for the first time the ERDC COBie Tool Kit will 
create a new subdirectory called “eManual.”  The COBie QC Manager may regenerate this 
information whenever needed.  Each time, the eMaual is created the former eManual sub-files 
will be entirely deleted and a completely new set of files will be produced.  

Reports are produced in web page (HTML) format. These files may be found in the “eManual” 
subdirectory.  The COBie file produced as part of the eManual will also be found in the 
“eManual” directory.  Documents and drawings files (in PDF format) are copied to the eManual 
sub-directory called “docs”.  All associated photographs (in JPEG format) are copied the 
eManual sub-directory called “pics”.   
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12.4. O&M Manual Outline 
The eManual produced by the ERDC COBie Tool Kit is provided in the format listed in this 
section. 

1. Cover Page (index.html) 

To update the eManual cover page a separate COBie Template will be created to allow the 
COBie QC Manager to update overall project and project participants. 

This page begins with the name and location of the project from the COBie.Facility data 

eManual Title COBie Data Field 
Facility Name: COBie.Facility.Name 
Project Name: COBie.Facility.ProjectName 
Site Name: COBie.Facility.SiteName 
Project Category: COBie.Facility.Category 

 

Next on this page information about the organizations responsible for this project are listed.  
This list is generated from information provided through the COBie.Contact worksheet.  
Specifically the all records with the following COBie.Contact.Category values will be listed.  
More than one firm may be listed.  This listing shall not identify individuals.  If more than 
one contact is given for a specific company on the first instance of matching 
COBie.Contact.Company information will be given.  

eManual Title COBie.Contact.Category 
Corps of Engineers District 34-20 41 00: Contract Administrator 
Corps of Engineers Resident Office 34-35 15 17: Project Engineer 
Architect 34-20 11 11: Architect 
Engineer 34-20 11 21: Engineer 
Prime Contractor 34-35 15 11: Contractor 
Subcontractor 34-35 15 14: Sub Contractor 

 
2. Publication Information  (publication.html) 

This page will provide information about the version of the ERDC COBie Tool Kit that 
produced the eManual and date and time of publication. 

3. Table of Contents  (content.html) 

This page provides one page that links all subsections of the Manual. 
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4. Room Finish Schedule (finish.html) 
 
This page will provide the complete set of tables that mirror the associated COBie Room 
Finish Template.  One table will be provided for each floor identified in the COBie.Floor 
data.  Due to the information layout of the COBie Room Finish Template, this page will be 
organized in landscape, not portrait, layout mode. 
 

5. Material & Equipment Schedules  (schedule.html) 

When creating the eManual a complete product schedule page, similar, to that found on a 
design drawing schedule will be provided in HTML format for each COBie.Type.Category.  
Within a given product type schedule all components and properties will be provided, sorted 
by COBie.Type,Name and COBie.Category.Name. 

The Material & Equipment Schedule page provides two indexes to each of these individual 
product schedule files.  The first index provides a listing of each schedule based on the 
assignment of its related COBie.Components to the COBie.Systems Tab.   

To ensure that the information found in the O&M manual has been updated based on the as-
built project conditions separate COBie Template will be created to allow the COBie QC 
Manager, or designated other, to update the COBie.Systems tab. The table below provides 
the eManual System Title to be assigned to a given COBie.System.Category.  If additional 
COBie.System.Categories are provided in the COBie file these will be listed by their 
COBie.System.Category name following the systems listed in the table below.  

eManual System Title eManual page COBie.System.Category 
HVAC System  hvac.html 21-04 30  : HVAC System    
HVAC Control System  hvaccontrol.html 21-04 80 10 50: Control of HVAC Systems 
Plumbing System   plumbing.html 21-04 20  : Plumbing    
Electrical System   electrical.html 21-04 50  : Electrical    
Fire Supression System  firesupression.html 21-04 40  : Fire Protection     
Fire Alarm System  firealarm.html 21-04 70 50 10: Fire Detection and Alarm 
Security System  security.html 21-04 70 10: Access Control Systems 
Data Communications  datacomms.html 21-04 60 10 : Data Communications    
A/V Communication  avsystem.html 21-04 60 30 : Audio-Video Communication    
Site Water Utilities  sitewater.html 21-07 30 10 : Water Utilities    
Site Electrical  siteelectric.html 21-07 40 10 : Site Electric Distribution Systm  
Elevators  elevator.html 21-04 10 10 : Vertical Conveying Systems    

 

In addition to the system-based index, another product and equipment schedule index is 
provided in the eManual.  This index is alphabetical by COBie.Type.Name. 
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6. Maintenance Procedures  (maintenance.html) 

Maintenance procedures will be identified by equipment type.  In some cases these 
procedures will be linked through the identification of maintenance submittals created from 
manufacturer documents in individual PDF files.  In other cases, book marks within larger 
manufacturer submittals will be referenced. In other, cases specific COBie.Job projects will 
capture these maintenance procedures.  

Regardless of how the information is captured, the eManual output will be developed by the 
ERDC COBie Tool Kit by extracting the COBie.Jobs for each COBie.Type. In addition, 
COBie.Documents categorized as “Operation and Maintenance” submittals will be listed in 
this section. 

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

7. System Operations Procedures (operation.html) 

Given the complexity of the physical and control connections between components in 
building systems, the following types of procedures may also be required to properly operate 
the facility.  The information below is contained in the COBie System Operations Plan 
Template. 

a. Start-Up Procedures 
b. Shut-Down Procedures 
c. Normal Operating Instructions 
d. Emergency Operating Instructions 

If these procedures were developed as stand-alone PDF files, then the files may be referenced 
in the COBie System Submittal Template.   In addition to these system-related procedures 
there are also different types of drawings used to assist facility managers to operate a given 
system.   The following documents may be cataloged as part of the COBie System Submittal 
Template.   

a. System Flow Diagram 
b. Referenced Drawings 

 
8. Testing Procedures (test.html) 

Testing procedures provided as stand-alone documents may be provided through either one 
of the COBie Type Submittal Template, the COBie Component Submittal Template, or the 
COBie System Submittal Template. Testing procedures may also be provided in the Type 
Plan Template or System Operations Plans Templates.  
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Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

 
9. Troubleshooting & Repair Procedures (troubleshooting.html) 

Troubleshooting and Repair Procedures provided as stand-alone documents may be provided 
through either one of the COBie Type Submittal Template, the COBie Component Submittal 
Template, or the COBie System Submittal Template. Testing procedures may also be 
provided in the Type Plan Template or System Operations Plans Templates.  

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

10. Manufacturers & Suppliers Schedules (suppliers.html) 

The list of each manufacturer and supplier are provided in this section based on previously 
submitted COBie Templates.  This list will be provided in alphabetical order.  An additional 
comma delimited file will also be created to allow facility managers to directly incorporate 
these manufacturers and suppliers into their email/phone book applications.  

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

11. Warranty Certifications (warranty.html) 

Warranty information is provided a series of tables sorted by alphabetical order by Product 
Type.  Within each of those tables the warranty certificates provided in the COBie Type 
Submittal Template will be linked.  The next section of the table will provide the complete 
contact information for the guarantor for that warranty as found in the COBie.Type 
worksheet.  The Warranty period for each Product Type will also be displayed.  Under that 
heading each individual component will be listed along with the start and end date of the 
warranty period for that specific component.  

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

12. Tests and Certifications  (test.html) 

Tests and Certifications COBie submittal documents are provided as linked documents 
through either one of the COBie Type Submittal Template, the COBie Component Submittal 
Template, or the COBie System Submittal Template.  

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 
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13. Parts and Consumables  (parts.html) 

Parts and Consumables information is provided in tables listed by Product Type.   

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

14. Training & Instructions (training.html) 

Training & Instructions COBie submittal documents are provided as linked documents 
through either one of the COBie Type Submittal Template, the COBie Component Submittal 
Template, or the COBie System Submittal Template.  

Internal bookmarks on these tables allow this information to be cross-referenced with each 
Product Type. 

15. Design Drawings  (drawing.html) 

Drawings of all types are provided as linked documents through the COBie Drawing 
Template.   This section will include Contract Drawings, Contract Amendments, and 
Contract Modifications. 

All documents in this category will be identified by selecting a value in the COBie Drawing 
Template “Facility Name”.  If appropriate, the optional template “Floor Name” column value 
will also be selected.  

Note that both the native design file and PDF design file are required.  

16. Fabrication Drawings  (drawing.html) 

Drawings of all types are provided as linked documents through the COBie Drawing 
Template.  

All documents in this category will be identified by selecting a value in the COBie Drawing 
Template “Facility Name” column.  If appropriate, the optional “Floor Name” column value 
will also be selected.  

All drawings in this category will be identified by selecting a value in the COBie Drawing 
Template “System Name” column.   

Note that both the native design file and PDF design file are required.  
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17. System Flow Diagrams Drawings  (drawing.html) 

Drawings of all types are provided as linked documents through the COBie Drawing 
Template.  

All documents in this category will be identified by selecting a value in the COBie Drawing 
Template “Facility Name” column.  If appropriate, the optional “Floor Name” column value 
will also be selected.  

All drawings in this category will be identified by selecting a value in the COBie Drawing 
Template “System Name” column.   

This type of drawing may be provided in PDF format only. 

18. Utility Connection Drawings (connections.html) 

Drawings of all types are provided as linked documents through the COBie Drawing 
Template.  

All documents in this category will be identified by selecting a value in the COBie Drawing 
Template “Facility Name” column.  If appropriate, the optional “Floor Name” column value 
will also be selected.  

All drawings in this category will be identified by selecting a value in the COBie Drawing 
Template “System Name” column.    

This type of drawing may be provided in PDF format only. 

19. As-Built Drawings  (drawing.html) 

Drawings of all types are provided as linked documents through the COBie Drawing 
Template.   This section will include Contract Drawings, Contract Amendments, and 
Contract Modifications. 

All documents in this category will be identified by selecting a value in the COBie Drawing 
Template “Facility Name”.  If appropriate, the optional template “Floor Name” column value 
will also be selected.  

Note that both the native design file and PDF design file are required.  

20. Design Calculations (design.html) 

Documents of this type will be provided as linked documents through the COBie Drawing & 
Design Template.   This section will include Design Calculations and Basis of Design 
documents. 
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All documents in this category will be identified by selecting a value in the COBie Drawing 
Template “Facility Name”.  If appropriate, the optional template “System Name” column 
value will also be selected to reference systems described in specific documents.  

It is expected that these files will be provided in PDF format. 

21. Installed Equipment Photographs (photo.html) 

The Contractor will provide links to all installed equipment photographs through the COBie 
Equipment Photos Template.  A minimum of one photo shall be provided for each product or 
piece of equipment with a nameplate bearing a specific serial number.  

22. COBie File (cobie.html) 

One single COBie data file shall be provided with the submittal.  The data provided in this 
COBie data file shall be provided in multiple formats to allow the use of this information by 
those receiving the information.  These data formats shall be created using the ERDC COBie 
Tool Kit.  The following COBie files shall be provided and referenced through this 
cobie.html page: 

• Excel native format (xls or xlsx) 
• SpreadsheetML (Microsoft XML 2003 format) 
• COBieLite 
• IFC 

{End of Document} 
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